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RIEDP Vision and Goal

Vision:
With minimal changes or effort, use popular GIS and
simulation source data formats to share and exchange

Simulation data products

Goal:
Standardize the rules, methods, and semantics for sharing

data from key stages of the simulation database generation
process, while leveraging (those) existing source data formats
commonly used in GIS and simulation applications
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Background and Problems Addressed by RIEDP

»Challenges

» Environmental data products are widely used in stand-alone or networked M&S
applications, including visualization, training, analysis, rehearsal, testing (using
traditional, VR, or AR visualizations)

» The process of building simulation environmental data products (or databases)

requires various types of source data, including (but not limited to) data in popular
GIS formats

» Variations and different parameters used in the databases building process can
significantly impact the interoperability of the simulation systems that use these
databases

» Semantics of the content in these formats are not always uniform or standardized

» RIEDP solution

- RIEDP provides a standardized terrain data generation process model that can be
used as a reference, and identifies the stages from which data can be shared

- RIEDP defines standard rules, methods, and semantics for sharing the content using
data formats that are common/popular today
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Key Topics and Problems in Database Sharing

When reusing data from a partner, you need to know

= How the database was built - Tasks performed or not
= How the database is represented - Conceptual Model

= How the database is spatially referenced - Spatial Reference Model
= How the database is structured -> Physical data model

= How the database is organized on the media -> Files/Folders/Hierarchies
= How well the database conforms to Standards - Compliance & Profiles

= Information about the data product - Metadata

No existing solution fully satisfies ALL of these requirements
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RIEDP Concepts and Standards

RIEDP effort has:

= |dentified/selected an initial set of common source formats
» Developed a Reference Process Model (RPM)

= Developed rules, methods, and semantics for expressing and sharing the
data, which includes:

» A Reference Abstract Data Model (RADM)

» Innovative metadata storage methods

» Rules for data organization

» Set of Profiles for sharing application-specific data products

» Definition of environmental/terrain objects and their characteristics, including
material characteristics for different sensor models and different fidelities

» Process-related attributes to support data sharing
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RIEDP Concepts and Standards (cont.)

Within SISO’s RIEDP Product Development Group, the work is
embodied in two standardization products:

= Product 1 — RIEDP Data Model Foundations with two coupled parts:

» Reference Process Model (RPM)
= High Level model of the database generation process

» Reference Abstract Data Model (RADM)

= Database concepts and principles for Tiles, Layers, Library, Spatial Reference, Relationships,
Metadata, ...

= RADM leverages the SEDRIS DRM concepts and uses the SRM
* Product 2 — RIEDP Detailed Features description:

» ldentification for geo-specific object instances and templates (features, 3D objects,
textures) within the Library, and the linkage between instances and templates

» Dictionary for feature and attribute semantics, and mapping with existing dictionaries

» Specifies list of features, attributes, attribution rules (feature-attribute relations), range
values, ... (EDCS used)
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RIEDP Reference Process Model (RPM)
Process Flow

= Typical Generation Process for a Database
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RIEDP Reference Process Model (RPM)
Data Flow Export Stage
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RIEDP Reference Abstract Data Model (RADM)
Main Components (conceptual)
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RIEDP Reference Abstract Data Mo
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RIEDP Reference Abstract Data Mod. =~ DM)

Repository

Catalog [
DB —

o}

0..1 *
| Library |< >

AN

0.1
22 \etadata Reference Table
—
Reference
. Tables
° Special Areas
Textures
Feature
01— Templates 3D MOdelé N |

h—1 Texture L~

3D Model o
Package T

A

|

I Raster Data I

¥ ]

Details in 3D
Model Package

| Elevation Data I Sub Diagram

I |

[Cimaseryome |

[ |

I Areal Instance I

I Point Instaflce I | Areal Template I

I I

J
2 -
\ = .‘% % = g Linear Instance 8 Linear Template ? og
[ [|_85% [_° I [ — Jo ] & v
| —
| I I Feature Attribute 3D Model Attribute
| - ] ———]

[Etevation Layer auribute|

Imagery Layer Attribute

[Rastor Layer Ativuse

I I Il

[Festure Layer Ativute

| I 1 AN : VAN

I FA_Value I I FA_Index | I 3DMA_Value I | 3DMA_Index |
I-Value I |-Index | |-Va|ue | |-Ir\dex |
— |
*
.
| refers to alrecord [n Table x [ \J/
_ | 7—:1 Material Charact | ILighl Point Charact I Visual Charact | | Other Charact I Attribution

I | I | I | I |

Light Point Mode Texture Mode <
*
!

| Hl ' i — ’ ; = I
10 J 10 J ‘J—I ;I I II—I

1 1 |—I 1 ” ,—I
M t d t D, Imagery Layer MD| [Other Raster Layer MD Feature Layer MD| [Feature Instance MD Special Area MD Feature Template MD 3D Model MD Reference Table MD' Texture MD

RIEDP Presentation 3 August 2020




Convergence

RIEDP Refe
rence Abstract Dat :

a MO #4  common forma
—High Level Concepts of a Datahase del (RADM) \C/;ariabilityf |
Showing areas of convergence and variahility —

: * 1
= e AN A 1 o Tiles, Layers Lihrary.
=0

qm-iﬂ;fatlata,

RIEDP Presentation
3 August 2020



RIEDP-exchange formats , o e

—~ e“-;.;.«.‘,.

The data formats required for RIEDP-compliant data exchange:
= GeoTIFF (revision 1.0 October 1995), for Terrain Elevation data.

= Shapefile (ESRI technical description White Paper July 1998), for instances, and possibly for classes of
Terrain Features and Vector data.

= GeoTIFF (revision 1.0 October 1995) or JPEG 2000 (ISO/IEC 15444 — Part 1) for Terrain Imagery data, as
well as other raster-based data.

= OpenFlight (version 16.0 or higher), for 3D models, both natural and man-made, placed on the terrain or
dynamically included in the environment.

= PNG (ISO/IEC 15948:2004), SGI RGB or SGI RGBA, image formats for texture maps, used in portraying
object surfaces and some terrain surfaces.

= In addition, XML (and associated XML schema) is used to provide those RIEDP-required data that is not
supported through the above formats.

NOTE :

= RIEDP does NOT impose RIEDP-required Formats for use within a Data Producer’s internal Processes
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RIEDP Data Organization

Physical Organisation on the Media
= Layers in Tiles or Region Folder

= Library

= Metadata
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RIEDP Data Organization
Details of Tiles Folders

Tiling Example

= Area : SO6W002 — SO5E001
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RIEDP Metadata - Organization

Metadata

= Successful data exchange relies
heavily on the appropriate use of
metadata

» Structured metadata

» Based on XML files for each component of
the RADM

» According to rules captured in XML
schemas
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RIEDP Metadata - Examples

Metadata

XML file for Elevation Associated XML Schema

1  <?xmlversion="1.0"encoding="utf-8"7?>

<?xml v.er5|on= 1.0 enCOd”:‘g= UTF-8" standalone= tru_e ?>" 2Elkxs:schema-xmlns:xs="http://www.»\/s.nrg/2001/XMLSchema"-attrihutanrmDefauIt="|.
- <ElevationLayerMetadata xsi:noNamespaceSchemalLocation="../0-Commc¢ 3

- <WholeLayer=> 4
- <WholeLayerMD> 5
<Description=Description of the Layer</Description= g
8

.

I--Déclarations--

T

<Provider>Name of the Provider</Provider>

. i N . <xsii - ion=" ions.xsd"/>
<License>=Conditions of the License</License> xs:include schemal ocation="Declarations.xsd"/

<Security>Unprotected </Security > 18 R ——
<Date>=2017-04-22</Date> 1 Elements-->
<Quality>Medium </Quality > 12 HIRIRIRIIHIHIK .
<Resolution>0,5 m</Resolution> 13 & <xs:elementname="ElevationLayerMetadata">
<Thumbnail>Thumbnail.file</Thumbnail> 1; EI Fxs:complexType>
xs:sequence
</WholeLayerMD> 165 <xs:e|?3ment~name='Who|eLayer">
</WholelLayer> 1782 <xs:complexType>
- <TileExcepts> 188 <xs:sequence>
- «<Except=> 19 | <xs:element-name="WholeLayerMD" type ="typeSimpleRasterLayer"/>
<List=Tilel;Tile2</List> 20 </xsisequence>
- <ExceptTileMD> 21 /xsicomplexType>
- PR P </xs:element>
<Desc.rl ptlon>D?sc"ptlon].'</oescrl ption= 235 <xs:elementname="TileExcepts" minOccurs="0"maxOccurs="unbounded">
<P.I'OVIdeI'> ?rovuder<{PrOV|der> = <xs:complexType>
<Licensex>License</License> 258 <xsisequence>
<Security>Unprotected </Security > 26 0 | <xs:element-name="Except"minOccurs ="0"maxOccurs ="unbounded">
<Date>=2017-04-22</Date> 27 <xs:complexType>
<Quality>Medium</Quality> 28 H <xs:sequence> o ) .
<Resolution>0,5 m</Resolution> 23 xs:element name ="List"type ="typeListString"/> "
</ExceptTileMD> 30 | xs-.element-name— ExceptTileMD" type="typeSimpleRasterLayer"/>
31 i </xs:sequence>
</Except> 32 r </xs:complexType>
- <Except> 33} - </xs:element>
<List=Tile1;Tile3</List> 34 </xs:sequence>
- <ExceptTileMD> 35 r </xs:complexType=>
36 </xs:element>
371 <xs:elementname="FileExcepts" minOccurs="0"maxOccurs="unbounded">
51 </xs:sequence>
52 I | </xs:complexType>
53 | </xs:element>

54 -</xs:schema>

RIEDP Presentation 3 August 2020



RIEDP Profiles

= RIEDP-compliant Data Products shall conform to one of the RIEDP Profiles

= A Profile specifies:
» A stage in the RPM
» Mandatory and Optional Data in accordance with the RADM
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RIEDP leverages/reuses existing Standards

Use resources from existing standards (SISO, ISO, NATO, OGC, IEEE)
= Specification of Geographical Information (OGC, IEEE)

Specification of Entity lIdentification (SISO SWG Enumerations)

Specification of Position and Orientation Data (ISO/IEC SEDRIS/SRM)
Identification of Objects / Features and their Attributes (ISO/IEC SEDRIS/EDCS)
Definition of a Representation Model of the Environment (ISO/IEC SEDRIS/DRM)
Specification of Metadata (ISO 19115, DCMI, DDMS, FGDC, EDS)

Alliance M&S Standards Profile (NATO MSG)

Complement this foundation for M&S applications (RIEDP focus)
= Make use of “de-facto” standards from the Military and GIS communities
= Consider also video-game industry “de-facto” standards

= Develop additional elements to address M&S-specific needs

RIEDP Presentation 3 August 2020



Summary

RIEDP provides what is needed to share Environmental data
= A Reference Process Model

= A Reference Abstract Data Model = T

= A Spatial Reference Frame

= A List of Formats from the GIS and M&S worlds

= A Semantic through attributes and attribution rules (product #2)

= An Organization on the Media
= A Metadata structure

= A set of Profiles
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RIEDP and SEDRIS - Similarities and Differences

Commonalities

= Open Standard for Exchange of Environmental Data
Main specificities

> SEDRIS is designed to address all types of > RIEDP focuses on a subset and application-specific data
environmental data

> SEDRIS is not designed to describe the database > RIEDP is designed to specifically address the database

generation process generation process
> SEDRIS defines a binary format (STF) > RIEDP relies on existing COTS formats
> SEDRIS provides APIs and Tools > Use of RIEDP relies on existing COTS Software & Tools

RIEDP and SEDRIS are complementary efforts

= RIEDP uses SEDRIS concepts, capabilities, and standards

» RIEDP Reference Abstract Data Model (RADM) - Influenced by and similar to SEDRIS DRM
» Reference Frame - SRM is used for position and orientation
» Attribution - EDCS will be used (candidate) (Product # 2)
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RIEDP and SEDRIS - Similarities and Differences (cont.)

Concept / Capability

DB Generation Process

Data Model
Supported Format(s)

Volumetric Data (e.g., weather,
ocean, space, CAT scan, etc.)

Polymorphic Representations

Topology

Data Organization / Hierarchy

Metadata
3D Models

Animation

Library

Profiles

High level, but comprehensive

Abstract at Concept Level; At Data Level dictated
by formats

Popular GIS and sim formats (e.g., Shapefile,
OpenFlight, GeoTIFF)

None

Link from features to 3D models

None

Limited to fixed theme and hierarchy

Specific
Supported through the format
Supported through the format

3D Models, Feature Templates, Textures,
Reference Tables

12 use profiles
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None

Explicit at Concept and Data Levels

SEDRIS Transmittal Format (STF)

3D Volumes, + Time, + Multiple Attributes

Multiple forms of representation of same object, all
fully related and integrated

Both for Features and Geometry

Any combinations of 13 types: by theme, by time, by
space partition, by LOD, by state, by classification, ...

Specific
Fully supported
Fully supported

Symbol, Sound/Audio, Color Table, Image, 3D Model,
Data Table, Property Set Table

Limited
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Take away

= RIEDP
» Takes benefit of the lessons learnt from all initiatives

» Reuses and relies on existing standards (such as SEDRIS ISO/IEC standards and
PNG ISO/IEC standard), as well as popular formats used in the community

» Represents the best common denominator by providing a Reference Process
Model (RPM), a formal Reference Abstract Data Model (RADM), relying on use of
existing Formats, specifying unique Profiles, and focusing on metadata and
attribution semantics

» Does not impose internal solutions on producers
» Provides a common data sharing approach that relies on a formal abstract data
model (RADM), along with specific metadata and attribution (Product #2)

= This allows the best sharing of data, independently from target
applications implementation, with a current scope addressing static terrain
and visual system data
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Take away (cont.)

= RIEDP Product 1, Data Model Foundations, was published in 2018

= RIEDP Product 2, Detailed Feature Description, is under development and
expected to be published in 2021, with following key topics being worked:

» List of Features (and themes)
» List of Attributes (including enumerants, applicable units, scale)
» Feature-Attribute relationships

» Attributions related to Material, Light, and Sensor characteristics for different user
levels

» Attributions related to database generation process

RIEDP Presentation 3 August 2020



Conclusion

= Thank you for your attention !

= Any questions ?

= Backup slides contain additional information on
requirements, data generation process, and future trends
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Environmental Data Requirements




Modeling and Simulation Requirements

Modeling and Simulation a very heterogeneous world

= Various Communities

» Engineers & Military End-Users
» Industry & MoDs

= Various Requirements
» From Analysis to Training and Mission Rehearsal

= Large Range of Simulation Tools
» L, V, C, and Combinations via Distributed Simulation
» Based on Models from the Real World Phenomena
» Networking with Information Systems

Standardized Representation(s) of the Environment
must reflect and support this diversity
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Various Systems and Participants
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Environment Requirements for an Aircraft Simulator
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Requirements / Large Areas
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Requirements / Fidelity

Not to mention different internal models in different ™=
simulation systems ...
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Requirements / Consistency
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Building the Simulator Database
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° aS ¢ Correlate the data

* Create missing data
 Format the data

* Intensify the data

e Specialize the data
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Additional issues for Distributed Simulation
Reuse — Correlation — Interoperability ....

Duplication of efforts

Duplication of Cost

Time to market
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M&S Interoperability

What it is Not

= The same Product and associated Solutions for everyone
» Does not work, certainly not in the international arena
» Puts innovation at risk

» What product to choose? Single solution sufficient ?

What it is

= Consistency in Modelling, associated Data and Semantics at Component Level
= Allowing Components to work together at System & System-of-Systems Levels

= Fostering Multiple-Provider Solutions (e.g. : I/ITSEC/OBW Federations)

Interoperability relies on Appropriate Standards
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Database Creation Process
and associated Issues
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Generation Processes vs Correlation and Reuse

coTS
spandards

s Standards
<r: "+ proprietary

»  100% Proprietary
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Data Transformation Process — Two main phases

Lol w——
-~ D
|
x

(——— M&S World
< v

Phase 1 Phas; 2
Cleam'é &

Intermediate

Source ; .
Environmental
Data
Enhancement Data Generation
Standardize here
at appropriate
Intermediate stages
Manual Work: 80% 20%
Computation Time: 0% 80%
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Visual DB

Radar DB

IRDB
Other Sensor
CGF DB
Maps

Others
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Source Data - Geographic Formats

GIS Worild

= DTED : Military terrain elevation data format, Mil-PRF-89020B n
= DFAD : Military vector format, SUPP1C2/3C, Edition2, Nov 1988 (obsolete) tN\@Q )
= VMAP : Military vector format, Mil-V-89033 swe o7

= SHAPEFILE : de-facto standard created by ESRI, O@eﬂ ac\&ag

= GEOTIFF : Public format for Geo-referenced imagery 6@0 i

GML : Public format from Open Geospatial Consortium
KML : created by Keyhole, Inc, acquired by Google in 2004, standard OGC KML

Application to simulation

= Used for Altimetry (DTED), Features (SHAPEFILE) (roads, rivers and building positions), Geo-
referenced satellite imagery (GeoTiff).

1 —=

= Contributing to consistency between Simulators target applications
» Visual System, CGF, ...
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World of
Source Data Imagery Formats ?chmﬂﬂ!“'a"

= BMP : developed by Microsoft & IBM

= ECW : developed by Earth Resource Mapper

= JPEG : created by a WG in partnership with ISO & CEI

= JPEG 2000 : common standard from ISO & UIT-T, ref ISO/CEI 15444-1
= RGB : developed by Silicon Graphics Incorporated (SGI)

= TIFF™ : developed by Adobe.

Application to simulation
= Texture for Terrain or objects

= Adding visual realism, without complex geometric models

RIEDP Presentation
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I na
orlds of Game 2
Source Data - 3D Models W Mcnitecmre

OpenFlight™ : created by MPI., now Presagis , de-facto standard

COLLADA : created by Sony CE (PS3) as an interchange format for 3D interactive
application, now Khronos Group

VRML : Virtual Reality Modeling Language, ref ISO/IEC 14772-1 & -2
X3D : ISO/IEC standard, Computer graphics and image processing - Extensible 3D (X3D)

Application to simulation

= Formats from 3D modelers (3DS ™, Maya ™, Creator ™, ...)
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Phase1 : Generation of the Intermediate Data

| Intermediate
Layered Source Data * Projection Conversions

* Format Conversions
» Tiling (mosaic)
* Harmonisation (between Tiles)
» Corrections of Source errors
» Alignment betwe E'I bls

Elevation

» Material Classification

Attribution Definition
» Assignation of 3D models to Classes
Definition of Procedural Generation
Rules for Features (Off-line

 Attribution Dmﬂd

» Creation of new models in Library

3D Models

oy
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Phase 2 : Generation of Target DBs

Intermediate
Data

(Tiled ) Elevation

o

(Tiled) Images

»
B S~
S s

<

Classification

o

3D Models

~
i

Creation of 3D Terrain
(Polygons, Levels of Detail,

Texturing (projection of
images on the 3D Terrain)

Intensification of terrain with

3D elements
(Cultures, Buildings, Netwo

Many Other things ’
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Runtime DB

=3P Terrain

= GEEBpecific "
Textures -
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X
Foarmm2T€ 3D objects
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Future trends

RIEDP Presentation 3 August 2020



Back to the Future

Major Trends in Geospatial Data

= Data in the Cloud

= Multi Source-Based (Crowd, UAYV, ...)

= |mpact of Regulations: IPR, Security, Quality

Key aspects « D20, used

= The Cloud must become clever in order:
» To allow Data Collection from non-Expert as well as Expert Contributors
» To deliver the Data according to Various Consumers’ individual needs
» To take into account System of Systems Interoperability Requirements

= Consequence for M&S
» M&S Requirements
» Platform dependant
» Leveraging Data & Tools from Geospatial and other COls
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Future Trends - Impact on M&S
Better Environmental Data Sources

Various
Contributors

GIS Provider L Other Providers

Request GIS Data
L GIS Web Services
Mission J
Command J -
DVD M&S

Request

| Current M&S l Future M&S
Current M&S Requirements Future Requirements
= GIS Data as is : Elevation, Vectors, Imagery = M&S oriented Data: Cleaned, Aligned, Multispectral, Customized,

= Additional information (Sensors, ...) from other Providers = Interested in details : Curbs, Door Knobs, Multi spectral

= Do not address details such as : Curbs, Door Knobs, = Address Regulations Issues (IT Security, IPR, ..)

= Access to data : Down|0ading from servers (FTP) = M&S Oriented Web Services: ConSiStent, in realtime (7)
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Future Trends - Impact on M&S
RIEDP contribution to MSaa$S

M&S as a Service (MSaaS) for Environmental Data

= This is for mid-term Future
» 10 years, may be less ?

= This requires appropriate standards el Temo\@{@'-
» DataModel, Interface, Metadata, ...

RIEDP is paving the Way by establishing the Foundations
allowing efficient sharing of Environmental Data
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